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2004                                            Instructor:  Carolyn D. Fuentes

Letter from Instructor:  Provided below is information in detail that describes procedures that is used Microsoft Word.  Please attach this document to your previous files pertaining to MS Word. 
	Guide to Writing Paragraphs, Essays, Letters, and Memos with Microsoft Word

	· NewDoc
· SaveDoc   
· OpenDoc
· CloseDoc
· PrintDoc
· FontSize
· Spacing
· TabStops
·  Page#s
· WordWrap
· ArrowKeys
· Keypad
· UndoKey
· Delete
· Cut&Paste
· Spelling
· CenterText
· Bullets


	

	
Starting a New Document When Opening Word

	· When you first open Microsoft Word, a blank page of a new document is already displayed on the screen. This document, named Document 1 at the top of your screen, has not been saved on your disk. If you want to start writing on this blank page, first tell the computer to save the document on your disk. This is an essential step; if you do not save your document, you will lose everything you have typed if your computer experiences an electrical power surge or power failure. 

· Follow these steps to save your new document: 

1. Click File on the menu bar, shown below:
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2. When the File menu appears, click Save As... on the File menu, shown on the next page.
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3. When the Save As dialog box appears, you must choose the location where you want to save your document. If you are saving on your home computer, Microsoft Word will probably save automatically in the folder named My Documents located on Drive C. If you are using someone else's computer, you will probably want to save the document on a floppy disk, which is usually located in Drive A. To change from the My Documents folder on Drive C to Drive A, click the button to the right of the Save In box and then click on 3 1/2 Floppy (A:), as shown below.
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4. After you have selected 3 1/2 Floppy (A), then click on the File Name box, shown on the next page.
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Press the Delete key or Backspace key to delete the automatic file name (Doc1) and enter your file name. (If you have already started typing, your word processing program may list the first few words of your document in the File Name box. You will probably want to delete those words and rename your document.)

5. Click the Save button [image: image5.png]


to save the file on your disk.

	
Saving Your Document

	· When you finish typing a paragraph in your document, or when you make any significant revisions in your document, you should develop the habit of clicking on the Save button [image: image6.png]


located on your desktop toolbar. If you do not save your document periodically, you will lose all of your changes if your computer should experience an electrical power surge or power failure. You should also save your document before you print it. When you ask your printer to print a document, you are actually running a new program. It is not unusual for a computer to malfunction just after the printing command is given. If you have not saved your document, it may be lost when the computer has to be restarted. 

· You have two choices for saving a document. 

1. If you are using the latest version of Microsoft Word (XP version) or the version of Microsoft Word that you are currently using is the only version that you will ever use to edit this document, follow number 1 below the images to save your new document. 

2. Please follow the steps beginning with number 2 below the images if you meet one of these conditions: 

· You are using Microsoft Works or some other word processing program and plan to open your document later in a different word processing program than the one that you are now using. 

· You are writing a document with Microsoft Word and plan to save your work and then open it for revision using another computer with a different version of Microsoft Word than you are currently using.

· If you do not follow those steps, your word processing program will not be able to read your document file. If you do not know what version of word processing program that you are currently using or that you will be using later, you can always click on the word "Help" on the menu bar at the top of your screen. When you click on "Help" the menu that drops will display the word "About." 
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· Click on "About" to learn the version that you are using:
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1. Microsoft Word automatically saves your writing as a Word document and places the file extension ".doc" after your document file name. Every time you type a paragraph or make any changes when editing your document, click the Save File button [image: image9.png]


. You can also click on the word File on the menu bar and then click on Save. If you have never saved your document prior to clicking on the Save button, or prior to clicking on File on the Menu bar and then clicking on the word Save on the File menu, then the Save As dialog box will appear on your screen. If the Save As dialog box appears, follow the steps listed above under "Starting a New Document when Opening Word." 

2. Always save your work before you finish writing for the day or before you run any other program, including printing your document. Failure to save your document may cause you to lose your document if there is a power failure or computer malfunction. Caution: If you are using a program other than Microsoft Word or if you are writing with Microsoft Word 97 or Word 2000 but you will later be editing your document on another computer that uses an earlier or later version of Microsoft Word or some other word processing program, then you should save your document as a file type other than "Word," as explained on the next page. 

3. First, click on File on the menu bar and then click on Save As on the File Menu:
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4. After you click on "Save As," the Save As dialog box will appear, as shown below. If you are saving your work on your own computer, go to the next step. If you want to save your work on a floppy disk, click on the button to the right of the "Save in" box and change to the floppy drive, as shown below:
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5. Look at the bottom of the Save As dialog box and you will see two rectangles, the first labeled "File name" and the second "Save as type." Click in the File name box, press your backspace key to delete the words in the box, and type the file name you wish to use. Then click on the button to the right of the Save as type box and choose the file type that you will use on your home computer. If you want to preserve your formatting (boldfacing, italics, bulleted lists, double spacing, etc.), click on the "Rich Text Format" option, as shown below.
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6. Once the document file name has been changed to a "rich text format" document, as shown below, click on the Save button on the right side of the dialog box. 
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7. If you are single spacing a document and not using boldfacing, bullets, etc., you can save your document as "Text Only." To do so, click on the "Text document" option, shown below:
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8. Once the document file name has been changed to a text only document, as shown below, click on the Save button on the right side of the dialog box. 
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9. To open a document that you have previously saved on your floppy disk, hard drive, or other storage device, continue with the steps below, "Opening Your Saved Document."

	
Opening Your Saved Document

	· When you want to edit a document that you have previously saved, as in the steps just above, you will need to open the document. You must remember where you have saved your document. By default, Microsoft Word always saves to the "My Documents" folder on the "C" drive of your computer unless you tell it otherwise. 

· When you want to view a document, all you have to do is open Microsoft Word, and then follow the steps below: 

1. Click on File on the menu bar and then Open to locate your document:
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2. When the File Open dialog box appears, scroll down the screen in the dialog box and locate your document. Click on the name of the document and then click on the "Open" button. If you saved the document on your "A" (floppy) drive, as in the steps just above, place your floppy disk in the computer, change your drive to the floppy drive, and then locate the name of the file. If you saved it in a "Rich Text Format," however, as in the steps above, then you will need to change the type of file from a Word document (.doc) to a "rich text format" document (.rtf), as shown on the next page, in order to locate the document:
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3. Next, click on the name of your file:
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4. Finally, click on the Open button to open your document. 
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5. If you want to view a document that you have saved on a floppy disk (or in "My Documents" on the "C" drive), open Microsoft Word and then click on "File" on the menu bar. Then click on "Open" to locate your document:
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6. When the File Open dialog box appears, change your drive to the floppy drive (unless you have saved it on the "C" drive). Also, change the type of file from a Word document (.doc) to a text document (.txt), as shown on the next page:
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7. Next, click on the name of your file:
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8. Finally, click on the Open button to open your document. 
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Closing Your Document

	· When you have finished typing, revising, or printing a document and you are ready to either open a new document or leave your computer, you should close your document first. This is an important step. If you do not close your document (and also close the program if you are finished using the computer), your work may not be saved on your disk. 

· Follow these steps to close your document: 

1. Save your work by clicking the Save button [image: image24.png]


or on the word File on the menu bar and then Save. 

2. Close the document by clicking File and then Close. 

· Follow these steps to exit the Microsoft Word program: 

1. Click on File on the menu bar and then Exit. 

2. Caution: If you are saving your work on a Zip drive disk or on a floppy disk, wait until the light on your disk drive stops flickering before you remove your disk. If you are saving your work on the hard drive of your computer and you are planning to turn off your computer, be sure the disk drive light stops flickering before you click on the Start button to shut down your computer. Failure to follow this step may cause you to lose your work or corrupt your file or disk. 

3. Caution: If you are using a floppy disk, the hard case around it will not protect the disk from food, liquid, or being bent. Always keep your disk in a hard protective case and keep it away from harm. Always be sure not to bend the metal or plastic slider on the top of your disk. If that piece of metal or plastic becomes creased or bent, you should not try to insert it into a computer, for you may damage the disk drive itself. 

· Caution: Microsoft Word permits you to open a new document without closing the one that is currently open. If you later want to return to your first document and you forget that it is already open on your computer, your computer will ask you if you want to revert to the saved version. If you answer "yes" and you have not saved your work, you will lose any changes you have made. To avoid this problem, either close one document before you open a second one or else remember that you have two documents open. Then if you want to switch to your original document, either close the one that is currently displayed on your screen or else click on Window on your menu bar and then click on the name of the other document that is open.

	
Opening a Previously Saved Document

	1. If you have saved a document that you wrote with Microsoft Word and now you want to open it for revision or printing, click the Open File button (located under the word File on the menu bar) [image: image25.png]


or on File and then Open.... 

2. Click the name of your document. 

3. Click Open. 

4. For information on opening a document that you saved under a different file type than a Word document (.doc), please click here. 

	
Starting a New Document After Closing

	1. Click the New button [image: image26.png]


on the left side of your desktop screen (just above the box that displays the word Normal). This will insert a new blank page with a 1-inch top and bottom margin and a 1¼-inch left and right margin. 

2. You may also click File and then New… and choose Blank Document or select another document type for your new document. 

3. Caution: If you start a new document file while you still have another document file open, don't try to re-open the document. If you do, you may lose any unsaved changes in the document that is still open. If you want to view that open document again, click on Window on the menu bar and then click on the name of your other open document to view it. 

	
Printing Your Document

	1. Before printing a document, you should always save it first. When you ask your printer to print a document, you are actually running a new program. It is not unusual for a computer to malfunction just after the printing command is made. If you have not saved your document, it will be lost when the computer has to be restarted. 

2. The next step before printing is to check the length of your document by clicking the Show/Hide button [image: image27.png]


beside the Zoom Control button on the Standard toolbar). If you see ¶ marks after the last paragraph in your document, use your Delete key to delete those extra blank paragraphs. 

3. To view your entire document before printing, click the Print Preview button (on the toolbar under the word View on the menu bar). If your document is slightly longer than one page, the computer will reduce it to fit on one page when you click the Shrink to Fit button. Be careful with this command, however. If the computer shrinks the document to fit on one page, the font size may be smaller than you would like it to be. If the font size is too small, then click the Undo button to return the document to its original size. You have two options at this point: (1) Decrease the page margins. (2) Insert a page break to move the last paragraph of the letter and the closing to the next page. 

4. To print your document, first save your document and then click the Print button (just under View on the menu bar). Click the button only once and then wait for the printer to warm up. 
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5. If you would like to print more than one copy or only the third page of a ten-page document, Use the Print dialog box. Click File on the Menu bar and then Print on the menu. 
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6. When the Print dialog box opens, choose your options, as shown on the next page, and then click the OK button in the lower right side of the dialog box to print the document.
[image: image30.png]printer

[Srwimare

Neme:
Status: Ide
Type: HP LaserJet 4 Plus
Where:  LPTL
Comment:

[Page range opies—
&al Number o
 Current page € Selection

g

Enter page numbers andjor page ranges
separated by commas. For exanple, 1,3,5-12





7. Note: If your document is connected to a network printer but the document does not print, save your document. Then click File and Exit. If you are using a a network printer, be sure that the network printer and its computer are turned on. Then go back to your computer, double click the Word icon, click File and Open... and open your document. Then click the Print button.

	
Changing the Font Size of Your Document

	· Paragraphs, essays, research papers, memos, and letters, are usually written in 12-point type unless the author is using 10-point or 11-point type to print more words on a page. If you are typing letters and memos for your business or if you are writing for a college class, 12-point Times New Roman font is the standard style for the style and size of the typeface. 

· Follow these steps to change all the text in a document from the default setting of 10-point to 12-point. (Note: If you want to change the font size of one letter or word, see #4 under "Cutting and Pasting and Copying Text.") 

1. Click Format on the menu bar and click Font... on the Format menu, as shown on the next page:
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2. When the Font dialog box appears, click 12 under the Size box, as shown below. Make sure the Font box indicates "Times New Roman" or whatever font you wish to be your default font, and that the Font style box is marked "Regular." 
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3. Click the Default... button on the lower left side of the dialog box: 
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Note: If you do not click the Default button, new text you enter as a bulleted or numbered list will not be 12-point type. When the Default dialog box appears, click the "Yes" button to change all your text to 12-point: 
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Changing the Line Spacing of Your Document

	· Paragraphs and essays are usually double spaced. To change the line spacing from single to double, follow these steps: 

1. Click Format on the menu bar. 

2. Click Paragraph.... on the Format menu.
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3. When the Paragraph dialog box appears, click the button under and to the right of Line Spacing and click on Double to change the line spacing to double.
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4. Finally, click the OK button to execute the command. 

· Memos are single spaced, with double spacing (one blank line) between paragraphs. One or two blank lines are left after the "SUBJECT" line of the memo and the body of the memo. 

· Business letters are single spaced, with double spacing (one blank line) between paragraphs. One or two blank lines are left between the return address or letterhead and the date. Three blanks lines are left between the date and the inside address. One blank line is left between the inside address and the salutation (greeting), between the salutation and the body, between each body paragraph, and between the concluding paragraph and the closing ("Sincerely yours,"). 

	
Using Tab Stops

	· Microsoft Word carries default tab settings of ½ inch. Each time you press the Tab key at the beginning of a paragraph, for example, the first line will be indented ½ inch. When you are writing essays or research papers, you should use the Tab key rather than the space bar to indent the first line of a paragraph. This procedure will ensure that the text begins at the same point, ½ inch indent, in the first line of each paragraph. 

· If you are typing a memo, press the Tab key after the headings at the beginning of the memo rather than the space bar to ensure even spacing between the heading and the text which follows, as shown in the example below: 

 

TO:
McDuff, Inc. Supervisors
 

FROM:
Richard North, Information Systems
 

DATE:
August 10, 1999
 

SUBJECT:
Using the Tab Key
· For more information on setting Tab stops to align the numbers at the decimal point or to create dots between a chapter title and the page number in a table of contents, please click here.

	
Inserting Automatic Page Numbering

	· If you are writing an essay, memo, letter, or research report that is longer than one page, you may wish to print a page number in the header or footer section (1/2 inch from the top edge or bottom edge) of your document. If you type the number yourself, it may be moved out of position as you edit your text. Instead, you should use the automatic page numbering feature of Microsoft Word. 

· To insert automatic page numbering in your document, follow the steps below. If you want to insert automatic page numbering with your name (or other text) printed in front of the page numbers, click here instead. 

1. Click Insert on the menu bar of your desktop screen and click on Page Numbers.... when the Insert menu appears.
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2. When the Page Numbers dialog box opens, as shown below, choose the position and the alignment. Your options for the position are either a header (top margin of the page) or a footer (bottom margin of the page). Your choices for the alignment are either left, center, or right. You will see these options if you click on the small button to the right of the options for position and alignment. 

3. Finally, decide whether you want the numbers to print on every page, including the first page. The default setting for Microsoft Word is to print the page number on the first page. If you do not want the number to appear on the first page, click the checked box in front of "Show number on first page." When the check disappears, click the OK button, and you will be returned to your document. 
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Note: You will not see the page numbers unless you click on View on your menu bar and then choose Page Layout. In the normal view mode, you will not see the page numbers except when you click on the Print Preview button or unless you click on File on the menu bar and then click on Print Preview.

	
Inserting Automatic Page Numbering
with Your Name or Other Text

	· If you are writing an essay, memo, letter, or research report that is longer than one page, you may wish to print a page number in the upper right corner of your document, preceded either by your last name, full name, name of the document, name of your client, etc. You should not type this page number and name at the top of each page. The reason is that if you later revise your document, you may either add or delete lines of text. Doing so may cause your page numbers to move from their original location. Also, if you send your document via e-mail to another computer or if you attempt to print your document from another computer with a different printer setup, then your page numbers may not appear on the top of each page. Instead, you should use the automatic page numbering feature of Microsoft Word. 

· With automatic page numbering, page numbers (and any text you would like to print with the page number) will appear in the header (usually 1/2 inch from the top of the page) of your document, no matter how many times you revise your document. (You can also place the page number in the footer of your document.) You will be able to see the page numbers when you are in the Print Preview view or the Page Layout view. When you are in the normal view, the page numbers will not be shown on your screen. 

· Follow these steps to add automatic page numbering with your name (or other text): 

1. Click View on the menu bar of your desktop screen.
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2. Click Header and Footer when the View menu appears. 

3. You will see the Header text box appear at the top of the page on your word processing screen. 
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Notice that your cursor (insertion point) is blinking on the left side of the Header text box. Look just above the header text box on the ruler and you will notice three preset tab stops: the first is aligned at the left margin, the second at the center of the page, and the last at the right of the page. If you want the text and number aligned on the right margin of your document, press the Tab key twice and your cursor will be aligned on the right of your screen. If you want your name to appear at the top of the page, type your last name, and press the space bar once. 

4. To insert automatic page numbering, first locate the Header and Footer dialog box near the top of your screen. This dialog box will appear on your screen just below the space in your document where the header will appear. Click the Page Numbers button in the Header and Footer dialog box to turn on automatic page numbering. This button is located on the left side of the dialog box and looks like a page with one corner turned down with the # sign displayed on the page. 

5. Now decide if you want the page numbering and your name to appear on the first page or all pages after the first page. If you want your name and page numbers on every page, go to the next step. If you do not want your name and page number to appear on the first page, click on the button that looks like an open book on the Header and Footer dialog box. When the Page Setup dialog box appears, click on the box beside "Different first page. Then click the OK button and go to the next step. 

6. Click the Close button on the Header and Footer dialog box. (You will not see the header unless you click View and then Page Layout.)

	
Using Word Wrap

	· Word automatically moves to a new line when your text has filled all the space on the line. 

· Press the Enter key only when you wish to begin a new paragraph.

	
Using the Arrow Keys, Mouse, and Scroll Bar

	· If you wish to change text that you have already entered, use the arrow keys to move up, down, left, or right to the point in the document where you wish to enter new text or delete text. If you enter new text, the other text will be moved over to make room for the new. 

· You may also use your mouse to move the pointer to the place in your document where you wish to enter text. Click the left mouse button once lightly, and then you may enter text or delete text at that point. If you cannot see all of your document, use the scroll bar on the right side of the screen. Drag the bar up or down or click the arrow buttons to view another portion of your document.

	
Using the Numeric Keypad

	· On the right of the letter keys on your keyboard you will find 10 gray keys. 

· Delete key deletes the character immediately to the right of wherever the cursor (insertion point) is blinking on the screen. 

· Home key moves the cursor to the beginning of a line of text. 

· End key moves the cursor to the end of a line of text. 

· Page Up key moves the text on the screen up one screen. 

· Page Down moves the text on the screen down one screen. 

· Insert key is a toggle switch for editing modes. When you open Microsoft Word, the program by default is in the Insert mode of editing. In the Insert mode you can click in front of any text you have already written, and any new text you type will be inserted into the document. The text already there will be moved over and down. When you press the Insert key, you will change from the Insert mode to the Overwrite mode. In the Overwrite mode of editing any text you enter will replace the text that is already there. To return to the Insert mode, press the Insert key again. 

· The up, down, left, and right arrow keys move the cursor up, down, left, and right across text already on the screen. To begin a new paragraph, use the arrow keys (or mouse) to move to the end of a line of text and press the Enter key. 

· The keypad on the right side of your keyboard can be used to move your cursor (insertion point) up, down, left and right or a full page up or down. 

· The Home key moves the cursor to the beginning of a line and the End key moves the cursor to the end of a line. If you hold down the Control key (Ctrl) and press the Home key, you will move your cursor to the beginning of your document. Ctrl End moves the cursor to the end of a document. 

· If you press the Num Lock key on the right side of your keyboard, the Num Lock indicator will turn on, and you will be able to use those keys as a numeric keypad.

	
Deleting Text

	· The Backspace key moves the insertion point (the point where text may be entered) backward and erases the text. 

· The Delete key and Del keys delete text in front of the insertion point (cursor). 

· Follow these steps to use these keys to delete blocks of text: 

1. To delete one word at a time, double click your left mouse button on a word. Then press the Delete or Del key. 

2. To delete an entire line, move your pointer to the left of a line until the pointer becomes an arrow pointing upward to the right. Click your left mouse button once and then the Delete or Del key. The selected text will be deleted. If you double click, the entire paragraph will be selected and may be deleted by pressing the Delete or Del key. 

3. If you press the Insert key or Ins key, you will see OVR highlighted at the bottom of your screen. Any text you enter now will erase the text in front of it. Press the Insert key or Ins key again, and new next will be inserted without deleting the old.

	
Cutting, Pasting, and Copying Text

	1. If you wish to cut text from one location in your document and move it to another, first select the text: 

a. Use your arrow keys to move to the point in front of the text you wish to select. Then move the arrow keys while holding the shift key down to select the text you wish to move. Or use the next option. 

b. Click and hold your left mouse button on the spot where you wish to begin selecting text and then drag your mouse until the text is selected. Then release the mouse button. 

2. Click the Cut button (the scissors icon, just below the word Insert on the menu bar) to cut the selected text from your document.
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3. Then use your arrow keys or mouse to move the insertion point to the new location for the text:
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4. Finally, click the Paste button (the clipboard icon, under the word Tools on the menu bar). When the selected text appears in the new location, be sure to save your document.
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5. You may also copy a block of selected text to a new location in a similar manner by using the Copy button [image: image44.png]


. 

6. If you wish to change the font size or font style of only one word, one line, or one paragraph or make only one word, line, or paragraph boldfaced, italicized, or underlined, select the text as described in #1 above. Then click the Font, Font Size, Bold, Italic, or Underline button to change the text. If you wish to change the color of the text, click on Format and then Font on the menu bar and then select the color you want from the choices in the Font dialog box.

	
USING THE UNDO KEY 

· If you make a mistake while writing or editing and wish to return your document to its original form before you made the mistake, click the Undo button (the left-curving arrow icon, located on the Standard toolbar under the word Table on the menu bar):
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Checking Spelling

	1. When you misspell a word or type a word not in Microsoft Word's dictionary, a red wavy line will appear under the word. 

2. Click the right mouse button to display suggested correct spellings. 

3. Click the correctly spelled suggestion, and Word will replace your misspelled word. If the word is a name of a person, place, or product which you know is spelled correctly but is not in the dictionary, click Ignore All, and Word will not stop on that word again unless you misspell it. 

4. If a word is not in the dictionary and you don't know how to spell it, click Spelling and follow the tips in the Spelling dialog box to correct the spelling and insert the word in your document.

	
Centering Your Title

	1. To center the title of your document, use your mouse or arrow keys to move your pointer to any point in the paragraph of your title. 

2. Then click the Center button on the Formatting toolbar (the second toolbar at the top of your screen above the ruler line and to the right of and under the word Help on the menu bar): 
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3. When you press the Enter key at the end of the centered line (or lines), the next paragraph will also be centered. If you want the next paragraph to be aligned on the left margin rather than centered, follow the next step. 

4. Click the Align Left button to return the next paragraph to the left margin. (Paragraphs may be aligned only on the right or on both sides by clicking the Align Right or Justify buttons.)
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